This is a context-sensitive Help file that is called from an application.



File New button O or Ctrl-N

Open a new, blank document.
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File Open button = or Ctrl-O
Open an existing document.

The Open dialog can also be used for finding, copying, moving and deleting files.



Print button =] or Ctrl-P

Prints the current document.
Using the print button will print directly. If you need to specify printing options (which pages to print), select Print
from the File menu or Ctrl-P instead.



Print Preview button & or Alt-F7

Previews the current document.



Copy button % or Ctrl-C

Copies the current selection to the clipboard.
You can subsequently paste it using Ctrl-V any number of times, in the current document, or in a document in

another application.



Cut button & or Ctrl-X

Cuts the current selection to the clipboard ready for pasting (using Ctrl-V ) in another location.
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Find button o] or Ctrl-F

Search the current document.
Depending on the context, Find can be used to locate text in a document, numbers or formula in a spreadsheet or
records in a database.



Paste button &, or Ctrl-V

Pastes the contents of the clipboard into the current document.



Redo button o or F4

Reverses the last Undo.
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Replace button #h or Ctrl-R

Search for, and replace, within the current document. Use this to replace some or all occurrences of the supplied
text.



Undo button = or Ctrl-Z

Reverses the last edit.



Insert Date button

Insert a date field. Choose a date format and whether to update the date automatically or insert it as static text.



Insert Document Title button

Insert the name of the current document.
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Insert Page Number button

Insert a page number field.



Insert Time button

Insert a time field. Choose a time format and whether to update the time automatically or insert it as static text.



Bold button = or Ctrl-B
Sets a bold font style for the selection.

Select bold again to turn off bold font style.



Bullets button *=
Turn current, or selected, paragraphs into bulleted style paragraphs.

Select the Bullets button again to turn bullet style off.
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Increase Indent button

Increase the left margin indent for the selected paragraphs.



Italic button o or Ctri-l
Sets an italic font style for the selection.

Select italic again to turn off italic font style.
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Numbers button =
Turn current, or selected, paragraphs into numbered style paragraphs.

Select the Numbers button again to turn the style off.



Center button

Center the current paragraph, or selected paragraphs, between the margins.



Justify button

Justify the current paragraph, or selected paragraphs, to create a smooth left and right margin.



Left Align button

Align the current paragraph, or selected paragraphs, to the left margin. This creates a ragged-right appearance.



Right Align button

Align the current paragraph, or selected paragraphs, to the right margin. This creates a ragged-left appearance.
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Decrease Indent button

Decrease the left margin indent for the selected paragraphs.
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Strikeout button
Draws a line through the selected text.

Select strikeout again to turn it off.



Underline button L or Ctrl-U
Sets an underline font style for the selection.

Select underline again to turn it off.
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Spell Check button v

Start the spell checker.
If there is no text selected, the entire document will be checked. If there is a selection, only the text within the
selection will be checked.



All Borders button

Apply left, right, top and bottom borders to the current paragraph or selected paragraphs.



Bottom Border button —
Apply a bottom border to the current paragraph or selected paragraphs.

Select the Bottom Border button again to remove the border.



Left Border button L.
Apply a left border to the current paragraph or selected paragraphs.

Select the Left Border button again to remove the border.



Remove Border button

Remove left, right, top and bottom borders from selected paragraphs.



Right Border button |
Apply a right border to the current paragraph or selected paragraphs.

Select the Right Border button again to remove the border.



Top Border button
Apply a top border to the current paragraph or selected paragraphs.

Select the Top Border button again to remove the border.



Ability Launcher S
Start the Launcher. If Launcher is already open, switch to it.

Launcher allows you to open any Ability file and start, or switch to, any other Ability application.
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Ability Database

Start the Database application. If Database is already open, switch to it.
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Ability Draw ™

Start the Draw application. If Draw is already open, switch to it.



Ability Spreadsheet [

Start the Spreadsheet application. If Spreadsheet is already open, switch to it.



View Footer button El

Switch from header to footer.



View Header button El

Switch from header to footer.



Zoom In button @l

Step up the magnification of the current document.



Zoom Out button a-

Step down the magnification of the current document.



Redo List button

Displays a record of undo's and allows redo to run to any point within the list.
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Show Borders button

Turn the display of the borders toolbar on and off.



Undo List button

Displays a record of editing and allows undo to run to any point within the list.



Border Line Style
Select and apply a line style for borders around the current paragraph.
Select the style (line thickness and pattern) by using the down arrow on the button.

Apply the style using the main part of the button.



Font Color

Select the color for the font.



Font

Choose a font for the current cell (or selection of cells).



Font Size

Choose a font size. Either:

- select the text you want to change and choose a font size.
- click on any word and choose the font size.

- position the cursor and choose the font size for new text.



Paragraph Shade Style
Select the background shading style for the paragraph.

The Clear style removes any paragraph shading.



Style
Select a paragraph and font style.

Modify and create new styles using the Styles command from the Tools menu.



Zoom

Select a zoom factor between 25% and 400% to magnify or reduce the current view.



Write document
This is where you type the text of your document.

Don't press Enter at the end of every line - just carry on typing and let Write format the paragraphs for you.



Application background
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This has no functionality whatsoever. If you want a document to start typing, select the New button ﬁ .



Horizontal Ruler

Provides a guide to the page area within the overall paper size. The ruler is interactive - you can change page,
paragraph and tab settings directly from the ruler.

Increase and decrease the left and right margin by dragging the ruler edge.
Increase and decrease the current paragraph indent settings by dragging the left and right indent markers.

Move both the left margin and indent settings together using the Shift Key before dragging the markers.

first line indent
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left indent tight indent

Drag any of the tab stops to a new location and change the tab alignment using right-click.



Vertical Ruler

Provides a guide to the page area within the overall paper size. The ruler is interactive - you can change top and
bottom margin settings directly by dragging the ruler edge.



Status Bar

Provides information on cursor location, whether you are insert or overwrite mode and whether the document has
been modified.



Shade Fore Color

The primary color used for the shade drawn behind the paragraph text.



Shade Back Color
The second color used in a pattern shade drawn behind the paragraph text.

Note that "Back Color" is only relevant if the Style is set to something other than "Clear" or "Solid".



Border Color
Select the color borders are drawn in.

If the current paragraph does not have a border around it, first use the Border Style button.



Border Style
Select and apply a border to the current paragraph.
Select the style (top, bottom, all etc.) by using the down arrow on the button.

Apply the border using the main part of the button.
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Mail Merge button B

Toggles mail merge mode on and off.

When set to on (depressed), print will step through every record in the attached table. The browse buttons will also
be available to view the data.

When set to off (button is up), print will print only the current record. You can still browse the data but you'll need to
select a field first (that is, double-click on it).
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Confirm button or Enter key

Save the current edit so that the result displays in the field.
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Cancel button or Esc key

Cancels the current edit and returns field contents back to previous state.



Add Record button +

Add a record. This button is only active in the Database application.



Delete Record button E‘

Delete the current record. This button is only active in the Database application.



First Record button )

Display the first record in the data.

This button is only available if mail merge is turned on (use the Mail Merge button @ ) or a field is selected

(double-click on it).



Next Record button 4
Display the next record.

This button is only available if mail merge is turned on (use the Mail Merge button @ ) or a field is selected

(double-click on it).



Last Record button M

Display the last record in the data.

This button is only available if mail merge is turned on (use the Mail Merge button @ ) or a field is selected

(double-click on it).
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Previous Record button
Display the previous record.
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This button is only available if mail merge is turned on (use the Mail Merge button M ) or a field is selected

(double-click on it).
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Insert Function button

Insert a function into the formula. There are over 200 built-in functions - use the help button in the function dialog
box to get information on each function.



Insert Field i

Insert the current field into the document.
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Sort Order button

Define a new sort order for the records.



Filter button
Define a new filter for the current record source.

A filter allows you to view only specified records, for example, all red wines from a general list of wines.



Insert Field i

Inserts the current field into the document.



Filter List

Select a filter from the named filters list. Select Filter - None to clear a filter.

AT
Use the Filters button to define a new filter.



Sort Order List

Select a sort order from the named sort orders list. Select Sort Order - None to clear any sort order.

A
Use the Sort button 2+ to define a new sort order.



Field List

Use the Field List drop-down to select a field and then use the Insert Field button to insert it into the

document.



Current Record Number

Display the current record number. You can type in a number to go to that record directly.
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This control is only available if mail merge is turned on (use the Mail Merge button BN ) or a field is selected
(double-click on it).



Formula Entry Bar

Type the text, number or formula you want for the current cell and press Enter.
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File New button ] or Ctrl-N

Open a new, blank document.
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File Open button or Ctrl-O
Open an existing document.

The Open dialog can also be used for finding, copying, moving and deleting files.



File Save button b or Ctrl-S

Save the current document to disk.
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File Print button ] or Ctrl-P

Prints the current document.
Using the print button will print directly. If you need to specify printing options (which pages to print), select Print
from the File menu or Ctrl-P instead.
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Print button or Ctrl-P
Prints the current document.
Using the print button will print directly. If you need to specify printing options (which pages to print), select Print
from the File menu or Ctrl-P instead.
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File Print button ] or Ctrl-P

Prints the current document.
Using the print button will print directly. If you need to specify printing options (which pages to print), select Print
from the File menu or Ctrl-P instead.
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Print Preview button ] or Alt-F7

Previews the current document.
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Cut button B or Ctrl-X

Cuts the current selection to the clipboard ready for pasting (using Ctrl-V ) in another location.



i

Copy button # or ctri-C

Copies the current selection to the clipboard.
You can subsequently paste it using Ctrl-V any number of times, in the current document, or in a document in

another application.
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Cut button B or Ctrl-X

Cuts the current selection to the clipboard ready for pasting (using Ctrl-V ) in another location.



i o
Find button or Ctrl-F
Search the current document.
Depending on the context, Find can be used to locate text in a document, numbers or formula in a spreadsheet or
records in a database.
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Paste button ] or Ctrl-V

Pastes the contents of the clipboard into the current document.



Repeat Format button c or F4

Applies the last formatting action to the current selection.
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Replace button #h or Ctrl-R

Search for, and replace, within the current document. Use this to replace some or all occurrences of the supplied
text.
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Undo button ] or Ctrl-Z

Reverses the last edit.
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Redo button ] or F4

Reverses the last Undo.
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First Record button ]

Display the first record in the data.
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Last Record button

Display the last record in the data
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Next Record button ]

Display the next record.
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Previous Record button

Display the previous record.









